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1. INTRODUCTION 

 

In international markets we must be able to localize our products and services. 

Computer and software industry is often considered so international that there 

is no need for localization. However, that is not true because for example in 

Chinese market you must be able to use local characters and symbols. Now 

there are many problems to implement Chinese letters to MHG ERP framework. 

The software developed by the company must can be understood by Chinese 

people if they what to sell it in Chinese market. We need to implement Chinese 

to MHG ERP framework and documents all steps and possible changes. 

 

The aim of the study is mainly to learn about NetBeans IceFaces 1.8.2 project 

and the use of ResourceBundle. MySql knowledge is also required in the whole 

project. 

 

The structure of the study is as follows. Firstly, I will introduce the basic 

knowledge in Chapter 2. 

 

Secondly, I will tell something about MySQL in Chapter 3. How to connect the 

NetBeans and MySQL, as well as how to built the work environment are the 

main topics which I want to talk about in this chapter.  

 

Then Chapter 4 describes the whole work I have done in MHG ERP framework. 

It is mainly the translation from English to Chinese. In addition, the test results 

and the outcome of the whole software will also be shown. 

 

Finally in Chapter 5, final conclusions are identified. 
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2. BASIC KNOWLEDGE 

 

2.1 IceFaces part 

 

2.11 The introduction of IceFaces  

“ICEfaces is an open source Ajax framework that enables Java EE application developers 

to create and deploy server-based rich Internet application (RIA) using the Java 

language.” 

“ICEfaces leverages the entire standards-based Java EE ecosystem of tools and execution 

environments. Rich enterprise application features are developed in pure Java, and in a 

pure thin-client model. There are no Applets or proprietary browser plug-ins required. 

ICEfaces applications are JavaServer Faces (JSF) applications, so Java EE application 

development skills apply directly and Java developers are isolated from doing any 

JavaScript related development.”[1] 

The figure2.1 shows the combine chart types below. 

 

 

 

Figure2.1  Combining Charts 
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2.12 How to install IceFaces 

 

Download and unzip ICEfaces-1.8.2-Netbeans-6.7-modules.zip to a local 

directory. After the zip file is unzipped, a subdirectory named “nbms” with 

2 .nbm files: 

· org-icefaces-netbeans-modules-web-frameworks.nbm ICEfaces Project 

Integration 

· org-icefaces-netbeans-modules-lib.nbm ICEfaces Run-Time Libraries 

Following instructions describe how to install ICEfaces Project Integration and 

ICEfaces Run-Time Libraries. 

1. From the main menu bar, select Tools --> Plugins. 

2. Select Downloaded tab in Plugins installation wizard and click Add 

Plugins... button. 

 

 

 

3. In Add Plugins file dialog, navigate to the directory where 

ICEfaces-1.8.2-Netbeans-6.7-modules.zip was unzipped. Navigate to nbms 

subdirectory and select org-icefaces-netbeansmodules-lib.nbm module and 

later on org-icefaces-netbeans-modules-web-frameworks.nbmmodule. Click 

Open button. 

 

  



 4

 

 

4. In Plugins installation wizard, check the Install checkboxes beside ICEfaces 

Run-TimeLibraries and ICEfaces Project Integration, and click Install button. 

 

 

 

5. In following dialogs, accept license agreement, follow instructions and 

finally press Closebutton. 

 

Please note that un-install any previous versions of the ICEfaces Project 
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Integration prior to installing thisplugin. 

 

2.13 Add ICEfaces Framework 

 

In order to create a web project with ICEfaces support, adding ICEfaces 

Framework to the web projects required. Follow these steps to create ICEfaces 

web project. 

1. From main menu bar, choose File → New Project... → Java Web → Web 

Application and press Next > button 

 

2. In Name and Location view, enter Name and Location of your project, and 

press Next > button 

 

3. In Server and Settings view, select runtime server, Java EE Version, and 

press Next > button 

 

4. In Frameworks view, press Configuration tab and select ICEfaces. (Do not 

select JavaServer Faces Framework here.) Select ICEfaces template as well. 

If this ICEfaces project is notICEfaces Facelets project, check 

welcomeICEfaces.jspx and uncheck welcomeICEfaces.xhtml. For ICEfaces 

Facelets project, see next section Add ICEfaces Facelets Framework. 
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. Enter any desired parameters in the options dialog. 

. Click Finish. 

.14 Add ICEfaces Facelets Framework 

 order to create a web project with ICEfaces Facelets framework support in 

s 

. From the main menu bar select Tools->Plugins 

. Click the Available Plugins tab, select Facelets Support, and click Install. 

. Click Next. 

5

 

6

 

2

 

In

Netbeans v6.7, Facelets support module is also required. Facelets module is 

available from Netbeans' update center and can bedownloaded and installed a

follows: 

 

1

 

2

 

3
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. Check the License Agreement accept box and click Install. 

. After the plugins are installed, click Finish, then Close. 

ollowing these steps to create ICEfaces Facelets web project. 

. From main menu bar, choose File → New Project... → Java Web → Web 

. In Name and Location view, enter Name and Location of your project, and 

. In Server and Settings view, select runtime server, Java EE Version, and 

. In Frameworks view, select ICEfaces and Facelets frameworks. Please do 

. Still in Frameworks view, highlight ICEfaces framework and click 

4

 

5

 

F

 

1

Application and press Next > button 

 

2

press Next > button 

 

3

press Next > button 

 

4

not selectJavaServer Faces. 

 

5

Configuration tab inICEfaces Configuration pane. Check 

welcomeICEfaces.xhtml and un-check 

welcomeICEfaces.jspx 
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6. Still in Frameworks view, highlight Facelets framework and click Libraries 

tab in Facelets Configuration pane. Select Facelets ICEfaces Run-Time 

library from Registered Libraries.[2] 
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2.2 Class java.util.ResourceBundle 

 

public abstract class ResourceBundle extends Object 

 

The following class of parent:  

ListResourceBundle, PropertyResourceBundle, Resourcebundles contain 

locale-specific objects.  

 

When the program needs a locale-specific resources, like String, program can 

load it in the resource bundle which is suitable for the environment of the 

current user. In this way, you can write most of code which independent of user 

language environment.It separates from the information of the most resources 

which are specific to the language environment.This can make the grogram: 

 

1.Easily localized, or translated into different languages 

2. With multilingual environment 

3.Can be easily changed the environment to support more languages in future 

 

A resource bundle is conceptually a collection of related classes, those classes 

are inherited from ResourceBundle. Each relevant sub-class of ResourceBundle 

has the same base name and logo of its language environment with additional 

components. For example, suppose your name of the resource bundle is 

MyResource.The first class you write may be the default resource bundle. It 

and its family has the same name-MyResource. You also can provide 

locale-specific classes as required. Like, you can give it a German name 

MyResources_de. 

 

Each related subclass of ResourceBundle has the same program. The program 

has been translated by the language environment which described by the 

subclass of ResourceBundle. For example, MyResources and MyResources_de 

may have a confirmation operation with a button in the String. In MyResources, 
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String may contain OK, in MyResources_de, it may contain Gut. We may 

make provision if different countries have different resources, For 

example:MyResource_de_CH is the resource of Switzerland. If you just want 

change a part of the resource,you can do this: 

when your program needs the special object of the language environment, it 

uses getBundle method to load ResourceBundle class: 

 

ResourceBundle myResources = 

      ResourceBundle.getBundle("MyResources", currentLocale); 

 

The first parameter specifies the family name of resource bundle which 

contains the doubt object. The second parameter specifies the desired locale. 

GetBundle use the two parameters to creat the name of the subclass of the 

ResourceBundle. It should be loaded with the following method: 

 

ResourceBundle uses different suffix to find class,base on (1)the desired 

language environment (2)the default langugage environment: 

 

baseclass + "_" + language1 + "_" + country1 + "_" + variant1 

baseclass + "_" + language1 + "_" + country1 

baseclass + "_" + language1 

baseclass 

baseclass + "_" + language2 + "_" + country2 + "_" + variant2 

baseclass + "_" + language2 + "_" + country2 

baseclass + "_" + language2 

 

The result of the search is a class, but this class may be supported by special 

files in the disk. If the search fails, getBundle() will throw 

MissingResourceException exception. 

The base class must be fully qualified. It must be the code which is runable, not 

the private class of the ResourceBundle.getBundle package 
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Resource bundles contain Key, Key is the only object which can identify the 

special language environment of the Resource bundles.Following is an example 

which contains the key of ListResourceBundle.[3] 

 

class MyResource extends ListResourceBundle { 

  public Object[][] getContents() { 

      return contents; 

      } 

  static final Object[][] contents = { 

  // LOCALIZE THIS 

              {"OkKey", "OK"}, 

              {"CancelKey", "Cancel"}, 

  // END OF MATERIAL TO LOCALIZE 

      }; 

 } 

  

The key always is String. In this example, keys are OkKey and CancelKey. In 

the example upside, the values are String—OK and Cancel.But they may be not 

like this. The values can be any object. 

 

Use the appropriate access method from the resource bundle to get an object. 

Because OkKey and CancelKey are string. We can search them using getString 

method. 

 

button1 = new Button(myResourceBundle.getString("OkKey")); 

 button2 = new Button(myResourceBundle.getString("CancelKey")); 

 

Access methods require the key as a parameter, and if found, then returned this 

object. If the object is not found, access method throws exception  

MissingResourceException. 
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2.3 Make Netbeans Icefaces project 

 

2.31 Define the properties files 

 

When I write the content of the ResourceBundle. I named two languages in the 

properties files.One is Chinese and one is Engish. 

 

myres.properties: 

aaa=good  

bbb=thanks 

 

myres_en_US.properties: 

aaa=good  

bbb=thanks 

 

myres_zh_CN.properties: 

aaa=好的 

bbb=多谢 

 

2.32.Creat the project and write the code of the web 

 

When creating the project, we must down load the Icefaces and use it as the 

framework. 

This is the code of the web page: 

 

 

<?xml version="1.0" encoding="UTF-8"?> 

 

<jsp:root version="2.1" xmlns:f="http://java.sun.com/jsf/core" 

          xmlns:h=http://java.sun.com/jsf/html 

xmlns:jsp="http://java.sun.com/JSP/Page"  
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          xmlns:ice="http://www.icesoft.com/icefaces/component"> 

 

      <jsp:directive.page contentType="text/html;charset=UTF-8" 

pageEncoding="UTF-8"/> 

 

    <f:view> 

            <html lang='zh'> 

                <head> 

                    <title>TODO JSP Page</title> 

                </head> 

                <body> 

 

                       <form method="POST" action="NewServlet"> 

 

                   <input type="submit" name="submit" value="中文"> 

                      </input> 

 

              <input type="submit" name="submit" value="Engish"> 

                        </input> 

                        </form> 

                </body> 

            </html> 

    </f:view> 

</jsp:root> 

 

Notice: In the "NewServlet" we define the action of the button. 
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The code of the NewServlet: 

 

 

import java.io.IOException; 

import java.io.PrintWriter; 

import javax.servlet.ServletException; 

import javax.servlet.http.HttpServlet; 

import javax.servlet.http.HttpServletRequest; 

import javax.servlet.http.HttpServletResponse; 

import java.util.Locale; 

import java.util.ResourceBundle; 

 

public class NewServlet extends HttpServlet { 

    protected void processRequest(HttpServletRequest request, 

HttpServletResponse response) 

    throws ServletException, IOException { 

         

      response.setContentType("text/html;charset=UTF-8"); 

        PrintWriter out = response.getWriter(); 

         String x=(String)request.getParameter("submit"); 

          

           if(x.equals("Engish")){ 

 

                Locale locale3 = new Locale("en", "US"); 

                ResourceBundle resb3 = 

ResourceBundle.getBundle("myres", locale3); 

  

            out.println("<html>"); 

            out.println("<head>"); 

            out.println("<title>Servlet NewServlet</title>"); 

            out.println("</head>"); 
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            out.println("<body>"); 

            out.println("<h1>" + resb3.getString("aaa") + "</h1>"); 

            out.println("</body>"); 

            out.println("</html>"); 

         } 

           else{ 

          

                 Locale locale1 = new Locale("zh", "CN"); 

                ResourceBundle resb1 = 

ResourceBundle.getBundle("myres", locale1); 

  

            out.println("<html>"); 

            out.println("<head>"); 

            out.println("<title>Servlet NewServlet</title>"); 

            out.println("</head>"); 

            out.println("<body>"); 

            out.println("<h1>" + resb1.getString("aaa") + "</h1>"); 

            out.println("</body>"); 

            out.println("</html>"); 

   

        } 

 

} 
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2.33 The result of the project. 

 

 

When you click the “中文” button, it will show the web page written in 

Chinese; 

 

When you click the “English” button it will show the web page written in 

English 
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3.HOW TO CONNECT MMYSQL WITH NETBEANS 

 

3.1 Installation and Configuration 

 

3.11 Basic installation of MYSQL 

 

First download MYSQL5.0 then we begin to install it Step by step: 
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Please note that image above select Custom option, so as to modify the installation 

directory 

 

 

  



 19

 

 

Please note that for data security, not to mysql installed on the system disk, such as the C: 

drive 
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Please note the image above setting, the number of simultaneous connections to 

mysql to 1000 
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Please note that image above, MYSQL service name of the selected "MYSQL", do not use 

other symbols 
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The password you create here is the password for login 

  



 25

 

 

Then we finish the installation of the MYSQL 

 

 

3.12 Configuration with MySQL 

 

Start the Command-line client of MySQL and enter the password of it. Then create a 

database named “mydb” by command “create database test”. We can check whether the 

database is created successfully by the command “show databases”[7] 
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3.13. Add mysql-connector-java to NetBeans 

 

First download mysql-connector-java from the internet. Then open the 

database view and click right to add a new driver to the drivers. 
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After this we have the MySQL (connector/J driver) in the driver 

 

 

 

3.2 The example of creating a connection between MySQL and NetBeans. 

 

First, I create an database named ”mydb” and there is a table named “LOGIN” 

inside. The table have two rows:”name” and “password”. Then I insert some 

values into the table. 

  



 28

 

Then create a new Java project in NetBeans named “NewClass” 

This is the code of “NewClass”: 

 

import java.sql.*; 

 

 public class NewClass { 

 

     public static void main(String[] args) { 

          String user = "root"; 

          String password = "hehang"; 

          String url = "jdbc:mysql://localhost:3306/mydb"; 

          String driver = "com.mysql.jdbc.Driver"; 

 

          String tableName = "LOGIN"; 

          String sqlstr; 

          Connection con = null; 
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          Statement stmt = null; 

          ResultSet rs = null; 

          try{ 

              Class.forName(driver); 

              con = DriverManager.getConnection(url, user, 

password); 

              stmt = con.createStatement(); 

              sqlstr = "insert into "+tableName+" values ('hanna','12345')"; 

             stmt.executeUpdate(sqlstr); 

 

              sqlstr = "select * from "+tableName; 

             rs = stmt.executeQuery(sqlstr); 

              ResultSetMetaData rsmd = rs.getMetaData(); 

             int j = 0; 

              j = rsmd.getColumnCount(); 

             for(int k = 0; k<j; k++) 

             { 

                  System.out.print(rsmd.getCatalogName(k+1)); 

                  System.out.print("\t"); 

              } 

              System.out.println(); 

             while(rs.next()) 

              { 

                 for(int i=0;i<j;i++) 

                  { 

                     System.out.print(rs.getString(i+1)); 

                      System.out.print("\t"); 

                  } 

                  System.out.println(); 

              } 

          } 
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         catch(ClassNotFoundException e1) 

          { 

             System.out.println("Not found the database！"); 

              System.out.println(e1.toString()); 

          } 

         catch(SQLException e2) 

          { 

              System.out.println("Exception of the database！"); 

              System.out.println(e2.toString()); 

          } 

         finally 

          { 

             try 

              { 

                 if(rs != null) rs.close(); 

                 if(stmt != null) stmt.close(); 

                 if(con != null) con.close(); 

              } 

             catch(SQLException e) 

              { 

                  System.out.println(e.toString()); 

             } 

          } 

      } 

 } 

 

The function of the code is adding a name ”hanna” and password “12345” to 

the table “LOGIN”. Then select the values in the table as well as show all the 

values. 
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We also can see the result of the database after executing the program. 

 

So we can see that the connection has been created successfully. 
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4.MHG ERP WORK 

 

4.1 What is ERP? 

 

ERP is short for Enterprise Resource Planning. It is a new generation of 

integrated management information systems which developed from 

MRP(Material Resource Plan). 

 

It extends the function of MRP, the core idea is to supply chain management. It 

jumped out of the traditional enterprise boundaries, the scope of the supply 

chain to optimize resources, is a new generation of Web-based Economy 

Information System. The role which improved business processes, enhancing 

the core competence of it is obvious. 

 

ERP started from the beginning in 80 years of twenty century. SAP, Oracle, 

represented by the famous international ERP products started in 90years. 

 

Characteristics and core of the ERP system are the following: 

 

1.Applications system which internal management enterprise needed, mainly 

refer to financial, logistics, human resources and other core modules. 

 

2.Logistics management system uses the MRP manufacturing management 

thought; FMIS effective implementation of the budget management, business 

assessment, management and accounting 

 

3.ABC Cost Absorption methods of modern basic financial management; 

human resources management system in organization design, position 

management, salary system and Human resources development, also advanced 

the concept of integrated 
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4.ERP system is a company-wide applications, highly integrated systems. Data 

in a high degree of sharing between the various business systems, all source 

data in one system only enter once, to ensure data consistency. 

 

5.The company's internal business processes and management processes are 

optimized, the main business processes automated.   

 

6.Mainstream computer uses the latest technology and architecture: B / S, 

INTERNET architecture, WINDOWS interface. Able to communicate in places 

where you can easily access to the system.  

 

7.Integrated, advanced, unity, integrity, openness 

 

Common function modules of ERP system: 

Forecast; 

Order management; 

Sale analysis; 

Purchasing management; 

Inventory management ; 

Inventory control ; 

Asset maintenance; 

Transportation management; 

Master Production Schedule(MPS); 

 

Product Data Management(PDM); 

Material Requirements Planning(MRP) ; 

Capacity Requirements Planning(CRP)  

Distribution Requirements Planning(DRP); 

Shop floor Control(SFC); 

Quality Management;  

Product Configuration Management; 
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Work Flow Management; 

Repetitive Manufacturing; 

General Ledger ; 

Accounts receivable(AR)； 

Accounts payable（AP）; 

Wage fixed; 

Cash; 

Manage cost; 

Multi-Currency Processing ； 

Human Resource Management; 

 

With the development of the new management ideas and emerging information .It will 

inevitably bring about the contents of ERP systems management software extensive and 

more functional modules. Even though, from the point of view of basic principles, ERP 

software system should include the basis of basic data management, production planning, 

production management, and supply and marketing management, financial and cost 

management, auditing and statistical analysis, six aspects.[4] 

 

4.2 The background of the whole MHG ERP work 

“MHG ERP is a platform and user interface independent service which can be used 

practically anywhere in the world, as it can be set to utilize several maps like national 

raster maps,  Google Premium Maps, satellite and customer´s own maps.” 

The service comprises the following independent modules: Power, Forest, Mobile, 

Tracking, Invoicing, and CO2-Tracking. MHG ERP Service is provided as three different 

basic services which always are customized to customer´s business model and practices in 

the best possible way. 

“MHG ERP is available as customer-based solution or ASP-Service with more than 10 

language options but without Chinese. So my job is adding Chinese words to MHG ERP. 

The service is easily implemented into new languages as well.”[5] 
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Figure4.1 MHG system login interface 

 

When you login, you come to the user interface management: 

 

 

 

Figure4.2 MHG system user interface 
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Figure4.3 MHG system interface 

 

4.3 What need I do? 

 

So the first step of my job is making the English words in the user interface (every menu, 

every notice) become Chinese. When the users choose the language button in the login 

interface. The whole language of the system will be Chinese. In this why, the Chinese 

users can understand it. 

 

I insert the AlertResources_ch.porperties to the “com.mhgsystems.ui” package 

 

 

Figure4.4 The picture of my work A 
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This is part code of the porperties file: 

 

 

 

Figure4.5 The picture of my work B 

 

In this way, I finish all the translation of the porperties file. This is a big project but all the 

things I need to do are translations. So it was not difficult for me. When I completed all the 

translations. The interfaces look like this: 
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Figure4.6 The Chinese login interface 

 

 
 

Figure4.7 The Chinese user interface 
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Figure 4.8 The Chinese MHG system interface 

 

However this was not enough. I also needed to translate the data in database. 

Because some of the words appearing in the users interface were called from 

database. 
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Figure 4.9 The Chinese MHG system interface 

 

 

Figure4.10 The picture of database 
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5. CONCLUSIONS 

 

5.1 Challenges and solutions of my final thesis 

 

During the whole project, I met many challenges with my work. Each 

challenge was a difficult question to me. Luckily, I worked out all of them.   

 

The first challenge of my work was in the connection between Netbeans and 

MYSQL part. When I download all the software and install them step by step. I 

tried all ways and all codes to make the connections come true. However, they 

ware all failed. 

 

Finally I found that not only should I install the mysql-connector-java, but also 

add the mysql-connector-java to the netbeans platform. Because the 

mysql-connector-java must be built on a specific platform. And the name of the 

MYSQL and the password in the code must be correct. Only in this way, the 

connection can be achieved. Although the solution was easy to do, it took me a 

long time to find it and understand it. 

 

 

The second challenges of my work was about the MHG ERP part. When I 

opened the MHG ERP project in Netbeans, it cannot be run normally. In other 

words, it cannot be shown in webpage. I thought this question was a little hard 

for me. So I asked my colleague in the company for help. And we worked out 

the problem together. 

 

The reason why I cannot open the webpage was that I did not configure the 

values of the localhoast. There were many values in the local host like 

connection pools and the way you connect. If you want open the webpage 

which includes the Mysql connection, you must complete the configuration of 

each program 
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5.2 What have I learnt in my job 

 

During the whole translation of MHG ERP framework, which impressed me 

the most is the professional words of the program. Because as an student from 

science department I really know few about how a company is run and what is 

the market about. There were just so many management words in the project. 

And in different solutions they might have different meanings. This was really 

a big challenge to me. Before the translation, I must get familiar with the 

product of the company. I must know what is the main function of it and try my 

best to master more management vocabulary. What was more, the cultural 

differences between Finland and China cannot be ignored. And we must 

translate the software depend on different customers. Though this final project, 

not only did I learn more knowledge of my subject, but also learned so much 

about the management. What was the most important, I worked for MHG 

company. It was really a good practice chance for me. 
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Appendix: A 

 

The code for example of ICEfaces: 

 

<?xml version="1.0" encoding="UTF-8"?> 

 

<jsp:root version="2.1" xmlns:f="http://java.sun.com/jsf/core" 

          xmlns:h="http://java.sun.com/jsf/html" 

xmlns:jsp="http://java.sun.com/JSP/Page"  

          xmlns:ice="http://www.icesoft.com/icefaces/component"> 

    <jsp:directive.page contentType="text/html;charset=UTF-8" 

pageEncoding="UTF-8"/> 

    <f:view> 

            <html lang='zh'> 

                <head> 

                    <title>TODO JSP Page</title> 

                </head> 

                <body> 

                     <form method="POST" action="NewServlet"> 

                        <input type="submit" name="submit" value="中

文"> 

                      </input> 

                        <input type="submit" name="submit" 

value="Engish"> 

                        </input> 

                        </form> 

                </body> 

            </html> 

    </f:view> 

</jsp:root> 

Appendix: B 



 45

  

 

The ues of java.util.ResourceBundle; 

 

import java.io.IOException; 

import java.io.PrintWriter; 

import javax.servlet.ServletException; 

import javax.servlet.http.HttpServlet; 

import javax.servlet.http.HttpServletRequest; 

import javax.servlet.http.HttpServletResponse; 

import java.util.Locale; 

import java.util.ResourceBundle; 

 

public class NewServlet extends HttpServlet { 

    protected void processRequest(HttpServletRequest request, 

HttpServletResponse response) 

    throws ServletException, IOException { 

         

      response.setContentType("text/html;charset=UTF-8"); 

        PrintWriter out = response.getWriter(); 

         String x=(String)request.getParameter("submit"); 

          

           if(x.equals("Engish")){ 

 

                Locale locale3 = new Locale("en", "US"); 

                ResourceBundle resb3 = 

ResourceBundle.getBundle("myres", locale3); 

  

            out.println("<html>"); 

            out.println("<head>"); 

            out.println("<title>Servlet NewServlet</title>"); 

            out.println("</head>"); 
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            out.println("<body>"); 

            out.println("<h1>" + resb3.getString("aaa") + "</h1>"); 

            out.println("</body>"); 

            out.println("</html>"); 

         } 

           else{ 

          

                 Locale locale1 = new Locale("zh", "CN"); 

                ResourceBundle resb1 = 

ResourceBundle.getBundle("myres", locale1); 

  

            out.println("<html>"); 

            out.println("<head>"); 

            out.println("<title>Servlet NewServlet</title>"); 

            out.println("</head>"); 

            out.println("<body>"); 

            out.println("<h1>" + resb1.getString("aaa") + "</h1>"); 

            out.println("</body>"); 

            out.println("</html>"); 

   

        } 

 

} 

 

 

 

 

 

 

 

Appendix: C 
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The example for how to connecti Netbeans and Mysql 

 

import java.sql.*; 

 

 public class NewClass { 

 

     public static void main(String[] args) { 

          String user = "root"; 

          String password = "hehang"; 

          String url = "jdbc:mysql://localhost:3306/mydb"; 

          String driver = "com.mysql.jdbc.Driver"; 

 

          String tableName = "LOGIN"; 

          String sqlstr; 

          Connection con = null; 

          Statement stmt = null; 

          ResultSet rs = null; 

          try{ 

              Class.forName(driver); 

              con = DriverManager.getConnection(url, user, 

password); 

              stmt = con.createStatement(); 

              sqlstr = "insert into "+tableName+" values ('hanna','12345')"; 

             stmt.executeUpdate(sqlstr); 

 

              sqlstr = "select * from "+tableName; 

             rs = stmt.executeQuery(sqlstr); 

              ResultSetMetaData rsmd = rs.getMetaData(); 

             int j = 0; 

              j = rsmd.getColumnCount(); 
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             for(int k = 0; k<j; k++) 

             { 

                  System.out.print(rsmd.getCatalogName(k+1)); 

                  System.out.print("\t"); 

              } 

              System.out.println(); 

             while(rs.next()) 

              { 

                 for(int i=0;i<j;i++) 

                  { 

                     System.out.print(rs.getString(i+1)); 

                      System.out.print("\t"); 

                  } 

                  System.out.println(); 

              } 

          } 

         catch(ClassNotFoundException e1) 

          { 

             System.out.println("Not found the database！"); 

              System.out.println(e1.toString()); 

          } 

         catch(SQLException e2) 

          { 

              System.out.println("Exception of the database！"); 

              System.out.println(e2.toString()); 

          } 

         finally 

          { 

             try 

              { 

                 if(rs != null) rs.close(); 
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                 if(stmt != null) stmt.close(); 

                 if(con != null) con.close(); 

              } 

             catch(SQLException e) 

              { 

                  System.out.println(e.toString()); 

             } 

          } 

      } 

 } 


